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Before you Begin…

Any computer program can only be as healthy as the computer 
on which it runs. Therefore, before getting started with Revealing® 
World Religions, take the time to learn about your computer and 
to understand its operating system. Are you starting with a healthy 
system? Do you have enough RAM to run the program? When was 
the last time you defragmented your hard drive? These factors can 
affect dramatically performance of all software, especially Revealing® 
World Religions, a multimedia program.

Do you backup your work in case of a disk failure? Are your backups 
safe and current? Do you have a plan to restore your drive in case of 
failure?

Your campus computer center can assist you with configuring your 
computer and planning a maintenance and backup strategy. A few 
minutes of time now can save hours or days of misery later.

Most importantly, always remember that, “To err is human, but to 
really screw things up takes a computer.” Backup often!

Installing Revealing® World Religions on 
Your Hard Drive

NOTE: If you are not installing Revealing® World Religions on the 
hard drive of your computer (for example, if you are working in a 
university computing facility), please skip ahead to the section of 
this User Guide titled “Running Revealing® World Religions from the 
DVD-ROM.”

To install your courseware on your hard drive, insert the DVD-ROM 
in the drive, and double-click the appropriate installer for your 
computer (Windows®: WR setup.exe; Macintosh® OSX: WR Installer 
Mac). Read the license agreement and the “Read Me” text. When 
the installer has finished placing the necessary software on your 
hard drive, quit the installer program. 

This is the only time you will need to use the installer. The first time 
you run Revealing® World Religions, you must have the DVD-ROM in 
your drive during registration.

Running Revealing® World Religions After It Is 
Installed on Your Hard Drive

Once you have installed your courseware, to start Revealing® World 
Religions, all you have to do is:

Windows®: Double-click the World Religions shortcut that was 
created on your Desktop or go to Start Menu, then All Programs, 
then Revealing World Religions.

Macintosh® OSX: Double-click the World Religions application 
that was installed in the Revealing World Religions folder in your 
Applications folder on your hard drive. It is best to put a shortcut 
to Revealing World Religions on your Dock (the strip at the side or 
bottom of your screen that contains your various application icons). 
To do this, go to your Applications folder and then open the folder 
called Revealing World Religions. You will see the World Religions.
app, which has an icon that is an circle with two wavy black lines. 
Drag this icon to your Dock, being absolutely sure not to release it 
until it is on the Dock. After you do this, you will see the icon BOTH 
on the Dock and in the folder from which you dragged it.

Running Revealing® World Religions from 
the DVD-ROM

NOTE: Follow these steps only if you are running Revealing® World 
Religions from the DVD-ROM. If you have installed Revealing® World 
Religions on your hard drive, please skip this section.

If you are using Revealing® World Religions on a shared computer, you 
must run the application directly from the DVD-ROM. To do this, 
you will need a USB flash/jump drive or other removable medium 
on which to store your user data files. The medium you will use will 
depend on the hardware available at the computer facility at which 
you are working. Please obtain the USB drive before proceeding.

The First Time You Run Revealing® World 
Religions from the DVD-ROM

Create User Data Files & Register

NOTE: This is the likely scenario if you are working on a university 
computer or another computer that is not your own. Please note 
that most universities will routinely delete anything that students 
place on the server or local hard drives so, you MUST have a USB 
flash/jump drive or another appropriate medium on which to store 
your data.

1. You will need the Revealing® World Religions DVD-ROM and a 
blank, formatted USB flash/jump drive as per the above.

2. Place both the DVD-ROM and your data storage device in the 
appropriate drives/slots.

3. Launch Revealing® World Religions from the DVD-ROM by doing 
the following:

A. Double-click on (My) Computer (skip this step if you are 
using a Macintosh®). 
B. Double-click on the Revealing World Religions DVD-ROM. 
C. Double-click on the Revealing World Religions folder. 
D. Double-click on World Religions.exe. (Depending on the 
settings on the computer you are using, you might not see 
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the “.exe”.) If you are using a Macintosh, double-click on the 
World Religions application’s icon.

4. The FIRST time you run Revealing® World Religions, you will need 
to register your software. So, on the first screen you see, click the 
REGISTER button.

5. On the next screen, choose to Store Your User Data On a USB 
Flash Drive (the big blue button on the right).

6. Click the BROWSE button.

7A. (Windows® Only) A dialog box will open. Use it to navigate to 
your data disk. Select the disk on which you will be storing your 
Revealing® World Religions data from the pull-down menu that is 
usually at the bottom of the window that opens.

7b. (Macintosh Only) In the Finder window that opens, navigate to 
your USB drive, select it, and then click the Choose button.

8. (Windows® Only) Once you have selected your data disk and you 
can see it in the top field of the window (you might also want to 
select a particular folder in which to store your user data), click OK.

9. A message will appear telling you where your WRUserData folder 
is going to be stored. Verify that this is correct and then click the 
Okay button.

10. Please wait patiently as files are copied from the DVD-ROM to 
your disk.

11. Next, the registration screens will appear. You need an active 
Internet connection during the registration process. Please fill in all 
of the information accurately.

12. When you click the Continue button to complete the 
registration process, you will need to wait a few moments as your 
software is registered.

13. You will see your Achievement Profile, as well as a status 
message indicating that your registration message was successfully 
sent to the Interactive Grade Book®, when the registration process is 
complete.

Running Revealing® World Religions from the 
DVD-ROM with User Data on a USB Jump/Flash 
Drive If You Have Already Registered.

NOTE: Follow these steps only if you are running Revealing® World 
Religions from the DVD-ROM. They presume you have already 
registered your courseware according to the instructions above. If 
you have installed Revealing® World Religions on your hard drive, see 
below.

Please be sure you have the Revealing® World Religions DVD-ROM 
and your USB jump/flash drive with your WRUserData folder 
available.

1. Insert the Revealing® World Religions DVD-ROM and your User 
Data disk/drive in the appropriate drives/slots. 

2. Launch Revealing® World Religions from the DVD-ROM by doing 
the following:

A. Double-click on (My) Computer (if you are using a 
Macintosh®, skip this step).

B. Double-click on the Revealing® World Religions DVD-ROM.

C. Double-click on the Revealing World Religions folder.

D. Double-click on World Religions.exe. (Depending on the 
settings on the computer you are using, you might not see 
the “.exe”.) If you are using a Macintosh, double-click the 
World Religions application.

3. When the Revealing® World Religions display with the Browse and 
Register buttons appears, click the BROWSE button at the right.

4. A dialog box will open in which you must select the WRUserData 
folder that is on your USB flash drive.

Windows®  
A. At the bottom of the window, click the arrow to show the 
list of all the drives on the computer. Select the drive that 
contains your data disk. 
B. A list of the contents of your data disk will appear. 
C. Highlight the folder called WRUserData at the top of the 
window. 
D. Click the OK button. NOTE: With certain Windows® 
configurations, this will open a folder in the window. If it does, 
please highlight WRUserData and click OK again.

Macintosh®  
A. Double-click on the USB drive on which you stored your 
WRUserData folder. 
B. Double-click your WRUserData folder. 
C. Click the Choose button.

5. A screen that says Revealing® World Religions will be displayed and 
you will be asked to enter your password.

6. After you enter your password and click the “Check” button. You 
will see your Achievement Profile.

Registering Your Software

You must register your copy of Revealing® World Religions to run the 
application. You must have an active Internet connection to register 
Revealing® World Religions. Please configure your system to connect 
to the Internet if you want to register your software.

If you are a student using Revealing® World Religions for a course, 
your registration will be entered in the Interactive Grade Book® once 
you have registered your courseware. As you work with Revealing® 
World Religions, you will send your progress reports to your 
instructor over the Internet (see Send Your Progress Report below).
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The first time you start up Revealing® World Religions, you will be 
asked to complete several forms identifying yourself, your copy 
of the software, and the course for which the software has been 
assigned to you. If any of this information changes during the 
academic term, you can update it.

Before you begin the registration process, please be sure you 
know the Pass Key for your class. You get your Pass Key from your 
instructor.

NOTE: If you do not know the Pass Key for your class, you can 
register Revealing® World Religions as a non-student to begin using 
your software. Then, once you know your Pass Key, you can update 
your registration information by double-clicking on your name on 
your Achievement Profile (see below).

Registration Entry Screen 1: User Information

Move from field to field on the registration screens using your tab 
or arrow keys or by clicking in each field. Complete the following 
fields on the first registration screen:

•	 First Name (required)

•	 Last Name (required)

•	 Street Address 1 (required)

•	 Street Address 2 (optional)

•	 City (required)

•	 State/Province (required)

•	 Zip/Postal Code (required)

•	 Country (required)

•	 e-mail address (required)

•	 Telephone (optional)

•	 Fax (optional)

After having completed all required fields, click the CONTINUE 
button or press the RETURN key to move to the next registration 
screen.

Registration Entry Screen 2: Are You a Student?

The second registration screen asks one question: “Was this 
software assigned by your instructor for use with a course?”

If Revealing® World Religions was assigned to you by your instructor 
for use with a course and you know your Pass Key, click the YES 
button. This will register you in your instructor’s Interactive Grade 
Book® and will allow you to send your results and progress reports 
to the Interactive Grade Book®, where they can be viewed by both 
you and your instructor.

If you are using Revealing® World Religions on your own or if you 
do not yet know your Pass Key, click the NO button to bypass the 
course information registration screen.

Registration Entry Screen 3: Course Information

You will see this screen only if this software was assigned by your 
instructor for use with a course. If you are using Revealing® World 
Religions as part of a course, you must complete the following 
registration information:

Pass Key (required): Your instructor will give you a Pass Key for the 
particular class, section, and academic term for which you have 
been assigned Revealing® World Religions. This Pass Key assures 
that your progress reports are sent correctly to your instructor’s 
Interactive Grade Book®.

After entering your pass key, click the CONTINUE button or press 
RETURN to move to the next registration screen.

Registration Entry Screen 4: Serial Number & 
Password

On the final registration screen, you must enter your serial number 
and create a password.

Serial Number: Type the serial number that is on a sticker inside 
your DVD-ROM package. The serial number is case-sensitive. You 
must type the hyphens.

Password: Type a password you will remember. You will need your 
password to use Revealing® World Religions. It is case-sensitive (so 
check to see if you turned on Caps Lock while entering your Serial 
Number).

Password Reminder: Type a short phrase that will help you 
remember your password.

After having completed the three required fields, click the 
CONTINUE button or press RETURN to complete the registration 
process.

If you have an active Internet connection, your software registration 
information will be sent to Thinking Strings and your course 
information will be sent to the Interactive Grade Book®.

Updating Registration Information, Student 
Information, or Password

You can update your registration information with Thinking Strings 
and your instructor when necessary (for example, if your e-mail 
address changes, your password has been compromised, or if you 
registered as a non-student and now know the Pass Key for your 
instructor’s Interactive Grade Book®).

You must have an active Internet connection to update your 
registration information.
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Go to your Achievement Profile (this will appear when you startup 
the courseware; or click the Star button at the lower left from 
anywhere within Revealing® World Religions).

Double-click your name at the top of the screen. Your current 
information for all editable fields will be displayed. Update any fields 
as necessary and then click the CONTINUE button.

Your updated information will be sent to Thinking Strings and 
the Interactive Grade Book®.

Organization of Revealing® World 
Religions

Modules

Revealing® World Religions contains twelve modules that you can use 
in any order:

•	 Exploring Religion

•	 Indigenous Religions

•	 Hinduism

•	 Buddhism

•	 Sikhism

•	 Daoism

•	 Confucianism

•	 Shinto

•	 Judaism

•	 Christianity

•	 Islam

•	 Religious Pluralism

Sections

Each module is broken into a number of sections. In turn, each 
section is divided into four basic parts. Each section begins with a 
single page outlining the learning goals. The presentation continues 
with narrated text and/or animation pages that explain more fully 
the concepts that comprise the section. A single summary page 
that reviews the main points of the section follows these concept 
pages. Finally, every section concludes with activities grouped 
together under “Try It” at the bottom of the third column on your 
Achievement Profile.

Control Bar

The control bar at the bottom of your window holds buttons (and 
one slider knob) for navigation, audio control, background music 
control, the Assistance Palette, the Achievement Profile, printing 
and copying pages, and quitting Revealing® World Religions.

Navigating with the Control Bar

Use the Previous Page (left arrow) and Next Page (right arrow) 
buttons to move backward and forward through the pages one 
page at a time.

Use the Page Slider Knob to quickly move to a particular page 
within the section where you are working. Click on the Slider Track 
(the horizontal line itself) to jump to a different page in the section 
in which you are currently working.

Use the Replay Page button (curved arrow) to restart the narrator 
and/or animation of the current page.

Use the Menu button (up arrow) to move between modules and 
sections.

Toggle Audio Elements On/Off

You decide which audio elements you would like to hear while using 
your courseware. To toggle the various kinds of sounds on and off, 
click the Sound On/Off button (speaker) at the right of the control 
bar. A menu of audio elements will be displayed. Those kinds of 
sounds that are marked with a “check” are turned on. To turn off 
a particular kind of sound, click it in the menu. The check will be 
removed. To turn on an audio element, click it in the menu again to 
show the check.

Open the Assistance Palette

To open the Assistance Palette, click the Assistance Palette button 
(question mark) at the right of the control bar.

Print Page

To print the title and text of any screen, click the Print Page button 
(sheets of paper) at the right of the control bar.

Copy Page

To copy the title and text of any screen to your computer’s 
clipboard, shift-click the Print/Copy Page button (sheets of paper) 
at the left of the control bar. Open the file into which you want to 
paste the text that has been copied to the clipboard. Then paste 
the text where you wish using the appropriate commands from 
the application in which you opened your file or your computer’s 
operating system (usually Ctrl/Command V).

Navigate between Modules & Sections
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Click the Menu button (up arrow) at the left of the control bar to 
move between modules and sections by selecting from pop-up 
menus.

Go to Your Achievement Profile

To go to your Achievement Profile, click the Achievement Profile 
button (star) at the left of the control bar.

Quit Revealing® World Religions

To quit (exit) Revealing® World Religions, click the Quit button (the 
“Q” character) at the right of the control bar.

Please Read the Following Section!

Backup Your User Data Files!

You should routinely backup your Revealing® World Religions user 
data files. This is an automated process that will only take a few 
moments. You should store your backup on a removable disk, 
such as a USB jump/flash drive, CD, or external hard drive, and you 
should keep that backup disk in a safe place. Do not store your 
backup on the same drive that contains your original files. With a 
current, external backup, your Revealing® World Religions user data 
files will be safe if a hard drive failure or other computing mishap 
should occur. If you can afford to lose only a week’s work, then 
backup once a week. If you can afford to lose only a day’s work, 
then backup once a day. Best of all, backup each time you quit the 
program.

To backup your user data files if you installed Revealing® World 
Religions on your hard drive, click the Backup button at the bottom 
of your Achievement Profile. You will be asked, “Where do you want 
to store the backup of your user data?” Click the Browse button. 
In the dialog box that will open, select the drive and (if necessary) 
the folder/directory on which you want to store your backup. Once 
your data have been backed up, you will see a message stating that 
“Your data have been backed up successfully to (your selected 
location).” Click the Check button to finish. Remove the disk on 
which you created the backup and store it in a secure location.

If you are running Revealing® World Religions from the DVD-ROM, be 
sure to regularly make a copy of your WRUserData folder and all of 
its contents to a second CD, USB jump/flash drive, or hard drive.

Navigation

There are many ways to navigate through Revealing® World Religions. 
You can jump to sections or concepts of your choice from the 
Achievement Profile, the Search Palette, and the Recent Pages 
Palette. To move around within a section, use the previous and next 
page buttons and the page slider control on the control bar at the 
bottom of your display. To move between sections or modules from 
any page, click the Menu button (up arrow) at the bottom left of 
the screen and make your selections through the pop-up menus.

Achievement Profile

Your Achievement Profile serves two major functions:

1. The Achievement Profile is an interactive Table of Contents from 
which you can navigate to any location in Revealing® World Religions.

2. You track your own progress through Revealing® World Religions 
on the Achievement Profile.

Navigating from the Achievement Profile

The Achievement Profile is displayed in three columns. The left 
column is a list of the modules that make up Revealing® World 
Religions. The center column is a list of the sections covered in the 
currently selected module. The right column is a list of the concepts 
covered in the currently selected section.

Roll over any item on the Achievement Profile to view a description 
of its contents.

Click on a module title to display the list of sections in the middle 
column.

Click on a section in the middle column to display the list of 
concepts in the right column.

Double click on any item in the center or right columns to jump to 
the first page of that item in Revealing® World Religions.

Tracking Your Achievements

As you work with Revealing® World Religions, your progress is tracked 
automatically. The star at the lower left of every page is white before 
you begin; once you have completed all of the work on any page 
you earn a gold star. When you have completed all of the work 
concerning a particular concept, section, or module, you earn a gold 
star on your Achievement Profile. Roll over any gold star on your 
Achievement Profile to view the date on which you completed that 
item.

Send Your Progress Report to the 
Interactive Grade Book®

IMPORTANT NOTE: Your work is not automatically sent to your 
instructor. You decide when to post your work to the Interactive 
Grade Book®.

To send your progress report to the Interactive Grade Book®, click 
the Send Progress Report button (envelope) at the lower right 
of your Achievement Profile. You must have an active Internet 
connection to send your progress reports. After you send your 
reports, you and your instructor can view your progress in the 
Interactive Grade Book®. The progress report contains information 
about all of the work that you have done in Revealing® World 
Religions EXCEPT for your responses on the Review (see below). You 
can view your progress posted to the Interactive Grade Book®. Open 
a browser and log on at this URL:
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https://interactivegradebook.com/session/new

Print Your Status Information

To print your current status information, click the Print Progress 
Report button (stack of papers) at the right of the control bar on 
your Achievement Profile.

The Assistance Palette

The Assistance Palette contains six tabs: Bibliography, Glossary, 
Help, Recent Pages, Review, and Search.

Open, Close, and Position the Assistance Palette

By default, the Assistance Palette will open automatically each time 
you start-up Revealing® World Religions. To deactivate the auto-open 
feature, click the small black and white target at the upper right of 
the Assistance Palette.

Position the Assistance Palette wherever you want to by dragging it. 
Close the Palette by clicking the little button at the upper left of the 
palette.

To open and close the Assistance Palette, click the Assistance Palette 
button (question mark) at the right of the control bar.

Navigate through the various functions by clicking the six tabs 
across the top of the palette.

Click the top title bar of the Revealing® World Religions main 
window to bring it in front of the Assistance Palette. If you are using 
Windows, you can leave the Assistance Palette open while you are 
using any module of Revealing® World Religions. If you are using Mac 
OSX, you must close the Assistance Palette for all of the features of 
the main screen to function.

Bibliography

The Bibliography tab of the Assistance Palette offers you a 
searchable bibliography of pertinent references.

To find the references you want, type a word, author’s name, year of 
publication, or any combination of these in the text entry box at the 
top of the palette and then click the Search button or press [return/
enter]. To narrow your search, enter multiple words or authors.

All of the references that match your search criteria are displayed in 
alphabetical order by author’s last name.

Browse through your found list with the scrollbar and the up and 
down arrow buttons on the right of the palette.

Print your found list of references with the Print button.

Copy references (into a word processor, for example) by selecting 
them and using the copy command [command/ctrl-C].

Glossary

Definitions of terms are provided in the Glossary tab.

To look up a specific term, type it in the search field at the top of 
the palette. You can also view groups of words by typing the first 
letter(s) of the terms. To scroll through all of the glossary terms, 
leave the search field blank and press RETURN or click the SEARCH 
button.

Glossary terms are displayed in the left column. Click on the left 
panel to be able to scroll through the terms. To view a definition, 
click on the term in the left column.

Help

The Help tab of the Assistance Palette contains a searchable user’s 
guide.

When you open the Help Palette, a scrollable list of major help 
categories is shown on the left. Click on any Help category to display 
a list of topics on the right. Click on a topic to learn more about it 
and to see a list of related topics. Click on a related topic to go to it. 
Click on the up arrow button to move back to the Help Contents 
page from a help topic display.

Click the left and right arrow buttons at the top of the palette 
to scroll through the help displays in the sequence in which you 
viewed them.

Click the Home button to move back to the beginning of the Help 
palette.

To find Help on a particular topic, type any word(s) in the search 
text entry field at the top of the palette and then press [return/
enter] or click the Search button. A list of relevant help topics will 
be displayed on the right of the palette. Click on a topic to view it.

Recent Pages

The Recent Pages tab of the Assistance Palette provides you with a 
list of all the pages you have visited during your current session with 
Revealing® World Religions. The pages are listed in the order in which 
you visited them, with the most recent page at the top of the list.

Each page is indicated with the name of the module in which it 
is contained and the title of the page. You use the scrollbar at the 
right of the palette or the up arrow and down arrow keys on your 
keyboard to scroll through the list, or click on a page title to select 
it.

To jump to a page in the Recent Pages list, double-click it.

Review

The Review tab offers you a series of multiple choice questions 
that you can answer at any time to test your knowledge. Go to the 
Review tab to answer questions concerning the section in which 
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you are currently working. When you change sections, the Review 
questions change.

NOTE: Your performance on the Review is NOT sent to your 
instructor’s Interactive Grade Book®. Use the Review to test your 
own knowledge of the material in a given module.

At the bottom right of the Review tab, an indicator shows your 
number of correct responses / the number of questions you 
answered in your current review session.

To answer a question, click on your response from the choices at the 
bottom of the palette. If your first response is correct, your tally of 
correct responses will increase. If your response is incorrect, you can 
click on the other choices to learn the correct response (of course, 
your tally of correct responses will not increase!).

If your response is incorrect, you might want to go to the Search tab 
and find a page on which you can learn more about the topic.

To reset your responses and begin to test your knowledge again, 
click the Reset button.

Use the left and right arrow buttons to move backward and forward 
through review questions. NOTE: If you pass over a question 
without choosing a response, your tally will not change.

Search

Use the Search tab to search for words or phrases throughout 
Revealing® World Religions.

Type a word or phrase into the search text entry field at the top 
of the Search tab and press [enter] or [return] or click the Search 
button. A list of all the pages that contain the word or phrase for 
which you searched is displayed. The name of the module in which 
it is contained and the title of the page are shown.

Use the scrollbar at the right of the palette or the up arrow and 
down arrow keys on your keyboard to scroll through the list, or click 
on a page title to select it.

To jump to a page in the Search list, double-click it.

Special Features

Image Captions 
To display the caption of a background image, place the cursor over 
the image, hold the option (Macintosh®) or alt (Windows®) key and 
click. The main text will be cleared from the screen and the image’s 
caption will be displayed. Click anywhere to clear the caption and 
continue working.

References and Web Sites 
Roll your cursor over the page title to see bibliographic references, 
web sites, and other useful information. To clear the display, just 
move your cursor off the page title.

Context-Sensitive Glossary 
Roll over the text on any screen. When the cursor changes to a 
pointer, that means the term you have rolled over is defined in the 
glossary. Click the term to read its definition.

Read Buttons 
On selected pages you will see Read Buttons. Click the button to 
display a text passage. Click it again to hide the text display.

Listen Buttons 
On selected pages you will see Listen Buttons. Click the button to 
listen to a relevant audio selection. Click it again to stop the audio. 
If you hear nothing, make sure your speakers are turned on and the 
volume on your computer is sufficiently loud.

File/Folder Structure

The program and data files for Revealing® World Religions must be 
kept in their correct locations to assure the proper functioning of 
your courseware.

If you have installed Revealing® World Religions on your hard drive

When you install Revealing® World Religions, the program files are 
contained in a folder called WR, which is contained inside a folder 
called Revealing® World Religions. If you are using Windows, the 
Revealing® World Religions folder is inside your Program Files folder. 
If you are using a Macintosh, the Revealing® World Religions folder is 
insider your Applications folder. When you register Revealing® World 
Religions, a folder called WRUserData is created inside the folder 
called WR. Your data files are contained in this WRUserData folder. 
Once you have registered your courseware, your WRUserData will 
contain these three files: WR.adb, WRDontDeleteMe, and UserData.
cst. If you delete or move any of these files, or change the name of 
the WRUserData folder or any of the files, your courseware will not 
work.

If you are Running Revealing® World Religions from the DVD-ROM

The program files are contained on the DVD-ROM, the file 
structure of which you cannot change. You store your data files 
on a USB jump/flash drive. Your data files are contained in a folder 
called WRUserData. Once you have registered your courseware, 
your WRUserData folder will contain these three files: WR.adb, 
WRDontDeleteMe, and UserData.cst. If you delete or move any of 
these files, or change the name of the WRUserData folder or any of 
the files, your courseware will not work.

Customer Support

Frequently Asked Questions

You will find the answers to Frequently Asked Questions (FAQ) on 
the Thinking Strings web site, along with helpful “hints” sheets that 
you can print out and keep by your computer while you are learning 
the program. Find them at:

http://thinkingstrings.com/Support/support.html
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Contacting Thinking Strings Support

If you experience difficulty using Revealing® World Religions or have 
questions, comments or suggestions concerning the software, we 
want to hear from you. Please contact Thinking Strings Support 
with the support form on the Thinking Strings website:

http://www.thinkingstrings.com/contact.php

Alternatively, you may e-mail Thinking Strings Support at:

support@thinkingstrings.com

When you contact Support please provide your full name, academic 
institution, the title of the courseware you are using, and your serial 
number. 

For virtually all situations, we will respond to your e-mail request 
within 24 hours on business days.

If we feel that a telephone conversation will accelerate resolution 
of the issue you describe in your e-mail, we will ask you to notify 
us of a telephone number and at least two alternate times we can 
reach you while you are at the computer. If you like, include this 
information with your initial e-mail request so that we can call you 
if necessary. Be sure to indicate your time zone along with the times 
you indicate.

Uninstall Revealing® World Religions

Before removing Revealing® World Religions from your hard drive, it 
would be a good idea to be sure you have a current BACKUP of your 
data.

To backup your data before you uninstall your courseware, you 
can launch Revealing® World Religions and then click the BACKUP 
button on your Achievement Profile. Or, you can move your 
WRUserData folder and all of its contents from its current location 
in the WR folder inside the Revealing® World Religions folder that 
is in your Program Files folder (Windows®) or Applications folder 
(Macintosh®). Be sure to put the WRUserData folder and its 
contents in a safe location outside of your Applications or Program 
Files folder, either on your hard drive or on another disk or drive.

To Uninstall Revealing® World Religions 
(Macintosh®)

Please delete the folder called Revealing World Religions (and all 
of its contents) that you will find inside the Applications folder on 
your hard drive.

To Uninstall Revealing® World Religions 
(Windows®)

After you have made a backup of your Revealing® World Religions 
user data, delete or move the folder called WRUserData (and all of 
its contents) from its location within the Revealing World Religions 
Program File folder.

To Uninstall Revealing World Religions (Windows):

1.	 Delete the folder called WRUserData (and all of its 
contents) from your hard drive. You can use the Windows “Search” 
function to locate this folder or double-click along the following 
path to get to it: My Computer, C: (hard drive), Program Files, 
Revealing World Religions, WR. NOTE: If you do not see your 
WRUserData folder, follow the instructions in the NOTE below.

2.	 Remove the Revealing World Religions application by 
going to your Start Menu, then Programs, then Revealing World 
Religions, then “Remove Revealing World Religions.”

NOTE: If you are using Windows Vista or Windows 7, WRUserData 
will likely be “hidden” or “invisible.” Please follow this procedure to 
make WRUserData “visible.”

1. Go to your Start Menu and Select “Control Panel.”

2. In the Control Panel, select “Appearance and Personalization: 
Folder Options.

3. In the Folder Options window, select the “View” tab.

4. In the View tab of the Folder Options, look to the bottom 
portion where it indicates “Advanced Settings.” Here, you have the 
ability to turn on/off options. Scroll down to “Hidden files and 
folders” and select the radio button for “Show hidden files and 
folders.” Then, click the OK button and close the window.

5. Go to your Start menu and then Computer and then go to the 
WRUserData by double-clicking along this path:

Start 
Computer 
Local Disk (C:) 
Users 
(Your Name) 
AppData 
Local 
VirtualStore 
Program Files 
Revealing World Religions 
WR

Thinking Strings Web Site

http://www.thinkingstrings.com/index.php


